
Using Microsoft FrontPage to Revise Your Website 
 

It is STRONGLY recommended that you access your site & CAPTURE all the image 
files before attempting to download your site to your hard drive. 
 
Digital Media World Wide, Inc. can provide you with your web site files on CD-ROM 
for a nominal fee of $50.00. Please contact us at 877-630-0504 for further information. 
 
Digital Media World Wide, Inc. cannot tutor you through the process of editing or 
maintaining your web site.  Courses on the use of MS FrontPage are available in most 
areas as continuing education courses or college courses or through private teachers.  We 
suggest Maintenance Contracts for those clients that do have the time or the skills to do it 
themselves.  For further information please contact us at 877-630-0504. 
 
Below you will find tech support. 
 
**********To Publish using Microsoft FrontPage 2002********** 
1 
 Open your local FrontPage Web 
  
 A. 
 Get Online using your Internet Service Provider (ISP) 
  
 B. 
 Open FrontPage on your Local Computer.  If the "Getting Started" Dialog box does not 
appear, then go to the "File" menu and select "Open FrontPage Web". 
 
(This assumes you have already saved your site on your local hard drive)  
     
 C. 
 When the "Getting Started" dialog box appears, click on the ''More Webs" button.   
  
 D. 
 When the "Open FrontPage Web" dialog box appears, type in "local host:" or the Full 
Path to your FrontPage web on your local hard drive in the "Select a Web server or disk 
location" box.  Then click on the "List Webs" button.  
 
E. 
 Now, a list of webs will appear in the "FrontPage Webs found at location" list box.  
Click on "<Root Web>" if that is the only one that appears in the list.  Then, click on the 
"OK" button to load you local FrontPage web.   
  
 F. 
 Your Web Site that you have created on your local computer is now loaded into 
FrontPage. 
  



2 
 Publishing Your Web Site to the Server   
  
 A. 
 Select the "File" Menu and click on the "Publish FrontPage Web" option.   
Do not click on the "Publish" button in the toolbar since this sometimes will not prompt 
you for vital options. 
  
 B. 
 When the "Publish" dialog box appears, click on the "More Webs" button.   
  
 C. 
 When the "Publish FrontPage Web" dialog box appears, type in the FULL URL to your 
web site (http://www.yourdomain.com) or, if your domain name has not been registered 
with the Internic yet, type in the Ip Address of your web site and click on "OK".  
 
Do not select the "Secure connection" check box. 
 
Click "OK" in the "Publish" dialog box to begin publishing your web site to the server.  
The status bar along the bottom of the FrontPage window will display the status of the 
publish operation. 
  
**For Further Tech Support regarding FrontPage consult the "Help" Menu found within 
the FrontPage program. 
 
 
**********Configuring a Form for Form Mail********** 
 
*****HTML Setup*****  
 
HTML Configuration 
 
1. Form Action Tag  
If you have already created your form, your page has a Form Action tag. Change it to 
look like this: 
 
<FORM action="/cgi-bin/FormMail.pl" method="POST"> 
 
2. Input Type=Hidden  
There are 3 parameters that are required. Put them in your page code right after the Form 
Action tag. Subject defines the subject line of the email you will receive when a user 
submits the form. Recipient is the email address of the person getting the form mail. 
Redirect is the URL the browser goes to after the user submits the form.  
<input type=hidden name="subject" value="Your Subject"> 
<input type=hidden name="recipient" value="email@my.com"> 
<input type=hidden name="redirect"value="http://my.com/thank.htm"> 



 
 
*****FrontPage***** 
 
1. Open the page that contains your form in the Editor. 
 
2. Right click within the form area and choose "Form Properties". Click the radio button 
next to "Send to other" and choose "Custom ISAPI, NSAPI, CGI, or ASP Script". 
 
3. Click the "Options" button. In the "Action" box, put "/cgi-bin/FormMail.pl". Then 
click "OK" 
 
4. Click the "Advanced" button in the Form Properties dialog box. You will have to Add 
3 hidden fields here: recipient, redirect and subject. Recipient is the email address of the 
person getting the form mail. Redirect is the URL the browser goes to after the user 
submits the form. Subject defines the subject line of the email you will receive when a 
user submits the form. 
 
5. Click OK to the Advanced Form Properties dialog box, then click OK again to the 
Form Properties dialog box. Save your work and exit.  
 
 
**********FTP Access********** 
 
*****WS_FTP*****  
 
1 
 Get a copy of WS_FTP 
  
   
2 
 Configure Your FTP Client   
  
 A. 
 Session Properties will appear add the following parameters: 
  
  1. 
 In the 'Profile Name' box, enter a title for your site so you can select it later on.  
 
  2. 
 In the 'Host Name/Address' box, enter your domain name.  If your domain name does 
not point, use your IP Address that we provided you when you signed off on final 
approval & requested site access. 
 
  3. 
 In the 'User ID' box enter the user name provided to you.  



  4. 
 Enter your 'Password'  
 
  5. 
 Do not select 'Anonymous' check box  
 
  6. 
 Optionally, you can select 'Save Pwd' (Save Password)  
 
 B. 
 Select the 'Startup' tab  
     
 C. 
 Enter '/httpdocs' in the top text box 
  
 D. 
 Optionally select the local directory to point to your local files 
Or traverse through the directories in the program later  
  
E. 
 Select 'OK' 
  
2 
 FTP Your Web Site 
  
 A. 
 Go to your Web Site Directory on the left side of the window 
and  
  
 B. 
 Select all of the htm, html, gif, and jpg files 
  
 C. 
 Hit the right arrow '->' in the middle of the pages   
  
 D. 
 All of your files will now be uploaded to your web site 
 
  
4 
 FTPing files using your web browser 
  
  If you have a 4.x or higher version of Netscape or Internet Explorer you can also FTP 
download and upload files using your web browser.   
 



This is NOT recommended for uploading your site or transferring a large number of files.  
This is only for the convenience of being able to upload or download a small number files 
from within your browser. 
 
To get FTP access to your site using a browser, type in the following URL in the URL 
bar at the top of your browser: 
 
ftp://<userid>:<password>@<yourdomainname.com> 
 
Where <userid> is your site user id and <password> is your site password and 
<yourdomainname.com> is your domain name. 
 
For example, if your user id is: web2 and your password is: apass3 and your domain 
name is: website.com, then the URL you type would be:   
 
ftp://web2:apass3@website.com 
 
Once you type this in and hit enter, you will see your home directory listed in the 
browser.  The directories will appear as links, which you can click on to traverse into 
them. 
 
A) Downloading a file: 
 
You can then right click on a file and select the "Copy to Folder" option to save the file 
on your local hard drive.   
 
B) Uploading a file: 
 
You can select a file or group of files from your hard drive using Explorer and then right 
clicking and selecting the "Copy" option.   Then, switch over to your browser where you 
are already FTP connected to your site, right click on a directory and select the "Paste" 
option.  This will FTP upload the files from your workstation to the directory you right 
clicked on in your site.  
  
  
*****Fetch***** 
 
1 
 Get a copy of Fetch 
   
2 
 Get Online with your Internet Service Provider (ISP) 
  
3 
 Configure Your FTP Client 
  



  One common use for Fetch is transferring web pages to web servers. Web authors often 
create their HTML, GIF, JPEG, etc. files on a personal Macintosh, and use Fetch to 
transfer the pages to the server that will actually serve the files over the Internet. This 
tutorial section is aimed at walking you through your first such transfer. 
Before you start, you will need to gather four important pieces of information:  
 
1) The hostname of the server that will hold your pages. It should be something like 
"yourdomain.com". 
 
2) Your userid, which you were given after signing final approval & requested site 
access. 
 
3) Your password,which you were given after signing final approval & requested site 
access.  
 
4) The name of the directory, which will hold your pages. Web pages are stored in a 
special directory named "httpdocs".  
 
To start, choose the New Connection... command from the File menu. Enter the four 
pieces of information in the four text fields, and press OK . If everything goes well you 
will see a list of the files in your web directory. Otherwise you will need to correct one or 
more of the pieces of information.  
 
Once you are connected, choose the Put Folders and Files... command from the Remote 
menu to upload your web page files. If all of the files are in one folder, you can navigate 
to that folder and use the Add All button to add them to the list of items to be uploaded. 
Otherwise you can choose them one by one. You can also add folders to the list of items 
to be uploaded. Next you will be asked what formats to use for the transfer. You want to 
choose "Text" as the format for text files, and "Raw Data" as the format for all other files 
(such as images). Then press OK to begin the transfer.  
 
Once the pages have been uploaded you should check them with a web browser. Enter 
the URL in the browser's Location field and check to make sure that all the images show 
up, and that all the links work. If there are problems you should double-check your 
HTML tags to make sure that they have the right file references. Your main page should 
be named "index.html" or "index.htm". CGI scripts need to go in a particular directory - 
/home/<username>/cgi-bin, and you will need to set their execute permission bit. 
  
4 
 FTPing files using your web browser 
  
  If you have a 4.x or higher version of Netscape or Internet Explorer you can also FTP 
download and upload files using your web browser.   
 



This is NOT recommended for uploading your site or transferring a large number of files.  
This is only for the convenience of being able to upload or download a small number files 
from within your browser. 
 
To get FTP access to your site using a browser, type in the following URL in the URL 
bar at the top of your browser: 
 
ftp://<userid>:<password>@<yourdomainname.com> 
 
Where <userid> is your site user id and <password> is your site password and 
<yourdomainname.com> is your domain name. 
 
For example, if your user id is: web2 and your password is: apass3 and your domain 
name is: website.com, then the URL you type would be:   
 
ftp://web2:apass3@website.com 
 
Once you type this in and hit enter, you will see your home directory listed in the 
browser.  The directories will appear as links which you can click on to traverse into 
them. 
 
A) Downloading a file: 
 
You can then right click on a file and select the "Copy to Folder" option to save the file 
on your local hard drive.   
 
B) Uploading a file: 
 
You can select a file or group of files from your hard drive using Explorer and then right 
clicking and selecting the "Copy" option.  Then, switch over to your browser where you 
are already FTP connected to your site, right click on a directory and select the "Paste" 
option.  This will FTP upload the files from your workstation to the directory you right 
clicked on in your site.  
  
    
**********CGI/Perl Scripts********** 
 
All customer perl scripts are to be located in the following directory: 
 
/home/<username>/cgi-bin/ 
 
 
The /cgi-bin directory itself and the cgi/perl scripts within must all be owned by the user 
and have the following rights: 
 
755 - (rwx r-x r-x) 



 
CGI/Perl Resource Paths 
 
Digital Media World Wide, Inc. allows all users to implement their own CGI/Perl scripts. 
There are a few common parameters that most scripts will require to execute, they vary 
depending on the configuration of the host. Below are some of these parameters that you 
may need to know when installing your own CGI/Perl scripts. 
 
Perl Path - #!/usr/local/bin/perl 
 
Sendmail Path - /usr/sbin/sendmail 
 
Date Path - /bin/date 
  
  


